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1 Important information 
Please follow these instructions before and during the use and application of any 
IPETRONIK product! 

1.1 Liability, Warranty, Copyright, License agreement 
1.1.1 Limitation of liability 

Any liability of IPETRONIK, its representatives, agents and the like, especially with regard to 
personal injury or damage to property of any kind, is excluded (within the legally admissible 
framework), as far as, the instructions and warnings, as mentioned below, have not been 
followed. 

1.1.2 Warranty 

Products, accessories and services have a 12 months warranty. 

All product data, specifications, drawings, etc., correspond to the current condition of the 
indicated creation date. For the purpose of optimizing technical processes and production, 
some details of our modules and accessory components may be modified at any time 
without prior notification. 

Although the present document has been prepared with the utmost attention to detail, it may 
not be exempt of misprints, typing or transcription errors. These errors are not covered by 
any warranty. 

1.1.3 Copyright and Duplication 

We reserve all rights, in particular those of property, copyright and trademarks. 

The rights related to any third party trademarks mentioned in the present document remain 
unaffected. 

This document may not be duplicated, partially or entirely without the prior approval from 
IPETRONIK GmbH & Co. KG. All graphics and explanations are copyright protected. Any 
use beyond the scope of the document is prohibited. 

1.1.4 Software license agreement 

This software is property of IPETRONIK GmbH & Co. KG, and is protected by copyright 
laws. Its total or partial reproduction is strictly forbidden. 

1.1.5 General license agreement 

IMPORTANT: READ THIS LICENSE CAREFULLY BEFORE USING THE SOFTWARE. 
THIS IS A LEGAL AGREEMENT BETWEEN YOU, LICENSEE, AND IPETRONIK GMBH & 
CO. KG/IPETRPOINIK INC. (“IPETRONIK”). BY CHECKING “I ACCEPT ALL OF THE 
TERMS CONTAINED IN THE ABOVE AGREEMENT” DURING INSTALLATION, COPYING 
OR USING THIS PRODUCT IN ANY WAY YOU ACKNOWLEDGE THAT YOU HAVE READ 
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THIS LICENSE AND THAT YOU UNDERSTAND AND EXPRESSLY AGREE TO BE 
BOUND BY THE TERMS AND CONDITIONS SET FORTH BELOW. 

The following actions are permitted: 

� Installing and using a copy of the product on a single computer or network. This 
copy may only be used by a single user at a time. If the product is to be used by 
multiple users, an additional license will be required for each user. 

� Creating a copy of the product for filing or backup purposes. 

� Using a copy of the product on a home computer or on a portable computer, 
provided that the copy is not installed at the same time also on your main computer. 

� Transferring the product to another person is only permitted if the license rights are 
also transferred, and if the product and any copies created are completely deleted or 
erased (including copies on hard drives), and if the new owner agrees with the 
requirements of this license. 
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2 General information 

2.1 About this manual 
The manual IPEmotion PlugIn CANSend describes the structure of the PlugIn and how to 
use the features for configuring devices, which are based on the CAN driver, in IPEmotion, 
taking acquisitions and managing and analyzing the resulting data. 

Please read the manual IPEmotion PlugIn CANSend carefully to get to know the operating 
and to learn more about the functions and special features. This manual also contains 
information for installing and removing the software. 

2.2 Version 

2.2.1 User manual IPEmotion PlugIn CANSend 

This manual has the version number 01.00. 

2.2.2 IPEmotion PlugIn CANSend 

The descriptions in this documentation refer to the current release with the version number 
01.00. 

2.2.3 IPEmotion 

The descriptions in this documentation refer to the current release with the version number 
01.09. 
 

 

The PlugIn requires at least IPEmotion V01.07 on your computer. 

2.3 Legend of the used icons 

 

Tip This icon indicates a useful tip that facilitates the application 
of the software. 

 

 

Information This icon indicates additional information for a better 
understanding. 
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Attention! This icon indicates important information to avoid potential 
error messages. 

2.4 Support 
Headquarter: 

IPETRONIK GmbH & Co. KG 
Im Rollfeld 28 
76532 Baden-Baden, Germany 

Phone +49 72 21 99 22 0 
Fax +49 72 21 99 22 100 

info@ipetronik.com 
www.ipetronik.com 

Limited commercial partnership with its head office in Baden-Baden, registry court HRA No. 
201313 
IPETRONIK Verwaltungs GmbH Baden-Baden is an individually liable society, 
registry court Mannheim HRB No. 202089 
Management: Erich Rudolf, Andreas Wocke 

Technical support and product information 

www.ipetronik.com e-mail: support@ipetronik.com  

2.5 Related documentations 

2.5.1 IPEmotion 

The documentation IPEmotion.pdf provides you with a description and useful information 
related to IPEmotion. This documentation is stored in the following standard language 
dependent directory: C:\Programs\IPETRONIK\IPEmotion Vxx.xx.xx\Help. 

2.5.2 Manual MAL development 

The documentation MAL development.pdf provides you with a description and useful 
information related to the use of the interface with plug-in components and  IPEmotion. 

2.6 Documentation feedback 
At IPETRONIK, the technical publications team strives to produce documentations of the 
highest quality and values your feedback as a reader and user. If you have any comments or 
suggestions regarding our product manuals, contact us under support@ipetronik.com. 

Please inform us about the following points: 
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 Version number (Select Options → PlugIns from the menu to display the version 
number.) 

 Name of the guide 

 Page number or section title 

 Brief description of the content (e.g. inaccurate instructions, grammatical errors, or 
information that require clarification) 

 Any suggestions for a general documentation improvement 
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3 Introduction 
The CANSend PlugIn offers you the ability to use a variety of different CAN hardware for 
importing, for instance, messages and signals from a CANdb. The CAN messages can be 
send via the CAN bus cyclically, as well as, event-driven. 

The CAN system types are separated into groups according their hardware family. The 
current version supports the following CAN hardware platforms: 

 Vector 

 Kvaser 

 IPEcan/PEAK 

 NI 

 Softing 

 TRAMA 

 M-WiFi 

 ICS-CAN 

 DrewTech 

 I+ME Actia 

Each single group contains different CAN types, which can be used for acquiring data. Each 
type is an independent acquisition system and can be used as a stand-alone devices, as 
well as, in combination with other types in a CAN bus network. The current IPEmotion PlugIn 
CANSend version offers the following hardware (they are listed accordingly to the above 
classification): 

 Vector: 

 CANcardXLe 

 CANcardXL 

 CANcaseXL 

 CANboardXL 

 CANboardXLcompact 

 CANcardX 

 Kvaser: 
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 LAPcan 

 PCcan 

 PCIcan 

 PCIcan II 

 USBcan II 

 Leaf 

 PCIcanx II 

 MemoratorPro 

 USBcanPro 

 BlackBird 

 IPEcan/PEAK: 

 IPEcan/PCAN-USB 

 IPEcanPro/PCAN-USBpro 

 NI: 

 PCI-CAN 

 PXI-CAN 

 PCMCIA-CAN 

 AT-CAN 

 USB-CAN 

 Softing: 

 CANcard2 

 EDICcardC 

 EDICcard2 

 CAN-Acx-PCI 

 CAN-Acx-PCI/DN 

 CANusb 
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 CAN-PROx-PCI 

 TRAMA: 

 CW-IUSB 

 M-WiFi: 

 M-WiFi 

 ICS-CAN: 

 ValueCAN 

 DrewTech: 

 Mongoose 

 I-ME Actia: 

 Basic+24 XS 
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4 Setting up and removing 

4.1 System requirements 
The minimum hardware and platform requirements for the application of the IPEmotion 
PlugIn CANSend are outlined below. 

4.1.1 Hardware 

The minimum hardware requirements correspond to those of IPEmotion. 

4.1.2 Platforms 

IPEmotion PlugIn CANSend can be run under the following operating systems: 

 Windows XP (32 Bit), 

 Windows Vista (32 Bit), 

 Windows 7 (32 Bit and 64 Bit). 

IPEmotion PlugIn CANSend                              IPETRONIK GmbH & Co. KG 11/ 18

 



  

Setting up and removing 

 

4.2 Installing IPEmotion PlugIn CANSend 
The following chapter guides you through the installation process of the CAN PlugIn. 
 

 

IPEmotion PlugIn CANSend needs administrator rights during the installation. 
For working with the PlugIn you need at least limited user’s or default user’s 
rights (Vista). 

The installation of IPEmotion PlugIn cANSend is based on an installation wizard that guides 
you through the setup process step by step. You can start the installation wizard from the 
USB flash drive or, if you have downloaded the setup program from the IPEmotion forum at 
www.ipemotion.com, from the setup file itself. 

To install IPEmotion PlugIn CANSend: 

1. Start the installation wizard from the USB flash drive or from the setup file. 

 USB flash drive: Connect the USB flash drive to the USB port of your computer and 
follow the instructions of the installation wizard. 

 Setup file: Browse the location of the setup file and double-click IPEmotion PlugIn 
CANSend.exe to start the installation wizard. 

 

 

Depending on the used PC operating system, a security warning appears. Click 
Run to start the installation wizard. 

2. Setup language/Setup-Sprache/Langue d’installation: Select the language for the 
installation process. You can choose between the languages German (Germany), English 
(USA), and French (France). 

Click OK to start the installation wizard. 

3. Welcome screen: This is the first screen in the installation wizard.   

Click Next to continue. 

4. Destination folder: 
 

 

Due to the security model of Microsoft Corporation related to .NET applications, 
the installation of IPEmotion PlugIn CANSend on a local drive is recommended. 

 

 

According to the Microsoft conformance guidelines for Windows applications the 
files are installed to the default locations that are specific to the operating 
system and language. 
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Accept the default installation location for IPEmotion PlugIn CANSend. To select another 
location click Change. 

After you have specified the location for the installation, click OK to return to the Destination 
folder screen.  

Click Next to continue. 

5. Ready to install the program: This screen indicates that IPEmotion PlugIn CANSend is 
ready to install. 

Click Install to start the installation. 

6. Installing: A progress bar is shown during the installation process. 

7. InstallShiel Wizard Completed: After the successful installation, the following screen is 
shown. 

Click Finish to exit the installation wizard. 

4.3 Uninstalling IPEmotion PlugIn CANSend 
The following chapter shows the deinstallation process of IPEmotion PlugIn CANSend. 

For removing IPEmotion PlugIn CANSend you have two possibilities: 

 With the option Remove of the installation program. 

 The option Add or Remove Programs for IPEmotion PlugIn CANSend in the 
Control Panel. 

With both methods you can remove files, folders and registry entries from your computer, 
which has been created during the installation. 

 

Removing IPEmotion PlugIn CANSend with the installation program 

To do so, proceed as follows: 

1. Click in the menu Start on your computer on Settings and then Control Panel. 

2. Double-click in the Control Panel on Add or Remove Programs. 

3. Select from the program list the entry IPEmotion PlugIn CANSend and click Change to 
start the installation wizard.  

Click Next to advance to the Program maintenance screen. 

4. Program maintenance: This screen allows you to modify, repair or remove IPEmotion 
PlugIn CANSend. Select Remove and click Next to continue. 
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5. Remove the program: This screen indicates that your installation is now ready to 
remove. Click Remove to start the removing process. 

6. Uninstalling: A progress bar is shown during the uninstalling process. 

7. InstallShiel Wizard Completed: This screen is shown after the successful deinstallation. 
Click Finish to exit the installation wizard. 

After removal, IPEmotion PlugIn CANSend is no longer indicated in the program list. 

 

Removing IPEmotion PlugIn CANSend with the deinstallation function of the Control 
Panel 

To do so, proceed as follows: 

1. Click in the menu Start on your computer on Settings and then Control Panel. 

2. Double-click in the Control Panel on Add or Remove Programs. 

3. Select from the program list the entry IPEmotion PlugIn CANSend and click Remove to 
start the installation wizard.  

4. Click Yes to start the deinstallation. 

5. A progress bar is shown during the uninstalling process. 

After the successful removal of IPEmotion PlugIn CANSend, the program has been removed 
from your computer and is no longer indicated in the program list. 
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5 Working with IPEmotion PlugIn 
CANSend 

The following chapter offers an overview of the available commands and their functions. In 
addition, it is shown how to use the CAN hardware and the IPEmotion software for 
configuring and acquiring data, as well as, managing and analyzing the acquired data. 

5.1 Defining general settings 
The main navigation tab Signals contains all available and connected systems with the 
respective CAN inputs. Click on the button Add system to expand the configuration by further 
systems. 

Using the automatic hardware detection, all CAN systems with the corresponding CAN 
inputs are automatically added to the configuration. 

 

 

To define the general settings for the system properties, proceed as follows: 
 

 

Please find detailed information about the functionality and meaning of the 
following IPEmotion parameters in the IPETRONIK documentation 
IPEmotion: General. 

 Select in the left tree view the desired system. You can find the Settings tab in the 
window of the configuration dialog. You can set the following definition: 

 Serial number 

The serial number is mandatory for detecting, using, and distinguishing the hardware 
from others within IPEmotion. 

Using the synchronization, all CAN systems that are not yet included in the configuration are 
added to the configuration with the corresponding interfaces. Those CAN systems that are in 
the configuration and that are not available are defined with the error status. 
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5.2 Defining CAN inputs 
 

 

To define the general settings for the CAN inputs, proceed as follows: 
 

 

Please find detailed information about the functionality and meaning of the 
following IPEmotion parameters in the IPETRONIK documentation 
IPEmotion: General. 

 Select in teh left tree view the desired CAN input. You can find the CAN tab in the 
window of the configuration dialog. You have the ability to select the following properties: 

 Baud rate 

The baud rate defines the transfer rate, which is valid for all system devices, for 
communicating to the devices. 

 Acknowledge 

The Acknowledge function (confirmation of the reception of a correct CAN message) 
is activated by default and should not be deactivated. 

 Within the Options tab, activate or deactivate the use of the baud rate at the 
interface initialization. 

5.2.1 Defining components 

To add a message and configure the send channel, proceed as follows: 

 Select the CAN interface and select Add components  and the Message  

entry. 
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 The Send channel in the Format tab offers the following definitions: 

  Data type (predefined) 

  NoValue 

 Define the value to be shown if the value is invalid. 

  Channel type (the use of the channel as an output is predefined) 

 You can also send event-driven standard and extended messages, which include 
 the complete message data (CAN-ID, DLC, Data). 

5.2.2 The import function  

Using the function Import, you have the possibility to read description files for the 
configuration of an acquisition. By doing so, vehicle data like air conditioning or seat 
adjusting for example are imported with the format CANdb. 

To use the function Import, proceed as follows: 

 Select the CAN input and click on the button Import . Select importing from a 
CANdb file .  

 

The dialog window Open file will be initialized. 
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 Select the desired file (*.dbc) with the channels to be imported. 

 Using the Open button, the description file will be imported and all included channels 
are listed in the left overview of the dialog window CANdb import. 

 Select the desired channels or click Select all. Confirm your selection with OK. The 
imported channels are listed. 

 


	Content
	Important information
	1.1 Liability, Warranty, Copyright, License agreement
	1.1.1 Limitation of liability
	1.1.2 Warranty
	1.1.3 Copyright and Duplication
	1.1.4 Software license agreement
	1.1.5 General license agreement


	2 General information
	2.1 About this manual
	2.2 Version
	2.2.1 User manual IPEmotion PlugIn CANSend
	2.2.2 IPEmotion PlugIn CANSend
	2.2.3 IPEmotion

	2.3 Legend of the used icons
	2.4 Support
	2.5 Related documentations
	2.5.1 IPEmotion
	2.5.2 Manual MAL development

	2.6 Documentation feedback

	3 Introduction
	4 Setting up and removing
	4.1 System requirements
	4.1.1 Hardware
	4.1.2 Platforms

	4.2 Installing IPEmotion PlugIn CANSend
	4.3 Uninstalling IPEmotion PlugIn CANSend

	5 Working with IPEmotion PlugIn CANSend
	5.1 Defining general settings
	5.2 Defining CAN inputs
	5.2.1 Defining components
	5.2.2 The import function 



